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Termination

Sequential Case

» A program terminates is every execution is finite.
» Useful property: in itself, prerequisite for soundness,
lock-freedom.
» Termination is well-studied:
» for functional programs (type systems, realisability),

» for imperative programs (abstract interpretation, loop
analyses),

» for rewriting systems (rewriting orderings, polynomial
interpretations).

Concurrent case
» More challenging: topology evolving at run-time (creation of
new services, sharing of informations).

» Existing results for the shared memory setting: Terminator
by Cook and al.



Starting point

We focus on the message passing setting.
Two different approaches to ensure termination.

Using weights

> [DengSangiorgiO6]

v

Assigning levels to service calls.

v

Defining a notion of weight for a system.

v

Ensuring that the weight of the system decreases at each
transition.

Using logical relations

v

[SangiorgiO6] and [YoshidaBergerHondaO4].

v

Considering only functional (immutable, replicated) services.

» Assigning types to these functional services.

v

Using logical relations to ensure termination.



Contributions of my thesis

Details

>

Complexity of type inference of weight-based type systems for
termination in the m-calculus (TGC'07).

Increasing the expressiveness of the weight-based type
systems, developing an hybrid analysis (IFIP/TCS’'08).
Termination of the higher-order concurrent systems
(FSEN'09).

Termination in impure languages (CONCUR'10).

Implicit complexity (work in progress with Ugo Dal Lago —
Bologna)
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Syntax

P:=0|(P|P)|(va) P|a(v).P|a(x).P.
» Names (or channels) a, b, ¢, x, y
> 0 is the inactive process.

» a(x).P: waits for channel x on channel a, then performs P (x
bound in P).

» 3(v).P: outputs channel v on channel a, then perform P.
» P; | Py: parallel composition.
» (va) P: restriction of ain P.

» Structural congruence =: | is symmetric, associative and has
0 for neutral element + scope extrusion:
(va) (P | Q)= ((va) P)| Q if ais not free in Q.



Semantics

P1—>P{

a(x).P1 | §<V>.P2 — Pl{v/x} | P2 (Pl | P2) — (Pi | P2)

P=Q Q@-Q Q=P
P— P

Example

» P; =a(c).0 | a(x).b(x).0 | a(y).y(2).0 | €(v).0
» either — a(x).b(x).0 | c(2).0 | €(v).0 — a(x).b(x).0
> or — b(c).0 | a(y).¥(2).0 | (v).0

Two prefixes consumed at each reduction: terminating calculus.



P:=0|(P|P)|(va) P|a(v).P|a(x).P| 'a(x).P.
Replicated inputs

» la(x).P: replicated input on a, persistent.

» Associated semantics:

la(x).Py | 3(v).P, —!la(x).P1 | Pi{v/x} | P2

» Source of divergence.



P:=0|(P|P)|(va) P|a(v).P|a(x).P| 'a(x).P.
Replicated inputs

» la(x).P: replicated input on a, persistent.

» Associated semantics:

la(x).Py | 3(v).P, —!la(x).P1 | Pi{v/x} | P2
» Source of divergence.

Removing trailing occurrences of 0
Notation for CCS-like channels: la.b.



Divergence

Definition
P diverges if there exists an infinite reduction sequence starting
from P.
Diverging processes
» D;=la3|a
» Dy=lab|!ba|2a

» D3 =c(x).lax |3 | c(a)
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Divergence

Definition
P diverges if there exists an infinite reduction sequence starting
from P.
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» D3 =c(x).lax |3 | c(a)



Divergence

Definition
P diverges if there exists an infinite reduction sequence starting
from P.

Diverging processes

» Dy =la3a | a— Dy
» D, =la.b ‘ 'b.3 ’ a—— D»
» D3 =c(x).lax |a|<c(a) — D;



Weight-based type systems



A rewriting-based type system

Principles

» Associate a level to each name through types (T ::=1b | ¥ T).
» Weight of a process: maximum level of an available output.

» Judgements - P :n



A rewriting-based type system

Principles

» Associate a level to each name through types (T ::=1b | ¥ T).

v

Weight of a process: maximum level of an available output.

v

Judgements Fr P : n

v

Control replications: k > n

v

Soundness: decreasing of the multiset of the available outputs.
Typing replication

FrP:n T@=¢T T(x)=T k>n
Frla(x).P:0




Ruling out diverging examples
» Dy =la"3" | 3"
» Dy =1a"b" | 13" | 3"

» D3 = ck(x).1a"x™ | 3" | c¥{(a).
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Ruling out diverging examples
» D; =la".3" | 3" not typable: n > n
» Dy =1a".b" | 1b™.3" | 3" not typable: n > m > n.
» D3 = ck(x).1a"x™ | 3" | c¥{(a).
c: 4 (4" T) implying n = mand n > m.

Decreasing of the weight

» Ti=la.(b |b |)|!b.(c |T)
» (Ty|a|b)—=(Ti|b|b|b]|c)—=>——rh.



Ruling out diverging examples

» D; =la".3" | 3" not typable: n > n
» Dy =1a".b" | 1b™.3" | 3" not typable: n > m > n.
» D3 = ck(x).1a"x™ | 3" | c¥{(a).

c: 4 (4" T) implying n = mand n > m.

Decreasing of the weight
» Ty =1a%.(b? | b2 | cb) | 2.(ct | )
» (T1 ]3| b)—=(T1i|b|b|b|CT)>——sA.

» {3,2) > {2,2,2,1} =+ {2,2,1,1,1} - {2,1,1,1,1,1} —
{1,1,1,1,1,1,1}



Ruling out diverging examples

» D; =la".3" | 3" not typable: n > n
» Dy =1a".b" | 1b™.3" | 3" not typable: n > m > n.
» D3 = ck(x).1a"x™ | 3" | c¥{(a).

c: 4 (4" T) implying n = mand n > m.

Decreasing of the weight
» Ty =1a%.(b? | b2 | cb) | 2.(ct | )
» (T1 ]3| b)—=(T1i|b|b|b|CT)>——sA.

» {3,2) > {2,2,2,1} =+ {2,2,1,1,1} - {2,1,1,1,1,1} —
{1,1,1,1,1,1,1}

Limitations
Not able to prove the standard encoding of Ast into 7.



Refining the analysis

Input sequences

» Principles: considering replicated input sequence as a whole.

> In la(x).b(y).c(z).P comparing {a, b, c} with the multiset of
outputs in P.

Partial order
» Encoding of list structures P; =!p(a, b).a(x).(b(x) | p{a, b))
with a and b having the same type.

> Introducing partial order in the typing judgements preventing
the typability of P; | p(u,v) | p(v, u).



Refining the analysis Il

Hybrid analysis

» Static analysis annotating type-checked processes (which can
diverge).
» Controlled execution: maintaining an order between names
and aborting the reduction if the system enters a loop.
» Example: P = c¢(x).!la.x | (¢(b) | b) | (c(a) | 3)
» Reduction with €(b): everything is fine.

» Reduction with €(a): aborted execution when [a > a] is
reached.



Refining the analysis Il

Hybrid analysis

» Static analysis annotating type-checked processes (which can
diverge).
» Controlled execution: maintaining an order between names
and aborting the reduction if the system enters a loop.
» Example: P = c(x).la.[a > x|x | (¢(b) | b) | (c(a) | 3)
» Reduction with €(b): everything is fine.

» Reduction with €(a): aborted execution when [a > a] is
reached.



Complexity of type inference

Type inference

» For a given process P, does there exists [ and n such that
FrP:n?

» Syntactically-directed type systems: type inference = level
inference.

First system

> a > b comparisons.
» Construction of a domination graph: (a, b) is an edge if a > b.

» Topological sort: polynomial inference.

With input sequences

» {a1,...,an} > {b1,..., by} comparisons.
» Reduction from 3SAT: NP-completeness of the inference.

» Version with algebraic sum: polynomial (linear -programming).



Termination using logical relations



A proof-theory-based method

Principles

» Using the encoding of Agt in 7.
» Termination of a functional subset of 7 by logical relations:
» Assigning types to processes. (Fr P: T)
» Defining inductively interpretation of types as set of
terminating processes. (P € [T])
» Proving that every typable process belongs to the
interpretation of its type. (Fr P: T = P €[T])

Limitations

» Limited “concurrent” expressiveness.

» Allowed inputs on f: (vf) (1f(x).P1 | P2) with f not free in
P1 and no reception of f in Ps.

» Yields a confluent calculus.



Termination of the standard m-calculus

» Difficult:
» Symmetry of | .
» No canonical types for processes.
» Simple typability of channels is not useful: (!a.3 | 3 can be simply
typed).



Combining the two approaches
An impure m-calculus
Termination by pruning
Also in the A-calculus



An hybrid solution

Principles

v

Combining the two methods to reach greater expressiveness.

v

Distinguish some names as functional in hybrid processes.

v

Extending the weight system to the functional part:
Using the weight to obtain a diverging functional process
from a well-typed hybrid process.

Derive a contradiction with the termination of the functional
calculus.

v

Ideas

» Papers from G.Boudol and R.Amadio on the termination of
Aref (A with references).

» Similarities between )\ and .
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Functional names

» Some names are functional

» Only one (replicated) input called definition:
def f = (x).Py in P,

» syntactical sugar for (vf) (1f(x).Py | P2)

» No “recursion” f ¢ fn(Py).

» Semantics with evaluation contexts
E=[]|(E|P)|def f=P; in E:

Ei[def f = (x).Py in Eo[f(v).Pa]] — Eadef f = (x).P: in Ea[Pi{v/x} | Pa]]
» Imperative names: a(x).P | 'a(x).P | a(v).



Typing
» Assigning a level to each name (either functional or
imperative).

» Imperative replication: weight of the continuation strictly
smaller.



Typing
» Assigning a level to each name (either functional or
imperative).

» Imperative replication: weight of the continuation strictly
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» Definition: weight of the continuation smaller or equal.
def f =3 inla.f | a



Typing
» Assigning a level to each name (either functional or
imperative).

» Imperative replication: weight of the continuation strictly
smaller.

» Definition: weight of the continuation smaller or equal.
def f =3 inla.f | a

» Name typing: T:=b [tk T |4k T  (and ik T)



Type system |

|—rP:/ |‘rP1:/1 }—rPQIIQ
|—r 0 -0 |—r (ua) P:l |—r P1 | Pz : max(/l,lg)

FrP:l Frvagh T Frw:T
Fr v{(w).P : max(k, /)

» [ typing context.
» Two kind of outputs treated simultaneously (v =a or v = f).

» Taking into account the outputs (either imperative or
functional) in the weight.



Type system I

FeP:l brad5T bex:T k>
Frla(x).P:0

FrP:l bra:gdT Frx: T k>1
Fra(x).P:0

Imperative inputs

> Replication controlled by k > /.

> Non-replicated imperative inputs treated as the replicated
one: def f = a(x).(x | a(x)) in f | a(f)



Type system IlI

Fr Pl Fra:ﬁ’fT Frx: T k>1
Frla(x).P:0

Fr Pl FrPy:l I—rf:ﬁ’l_fT Frx: T k> 1

f ¢ f(P1)

Frdef f = (X).Pl in Ps : 4

» Control k > [ on definition.



Type system IlI

Fr Pl Fra:ﬁ’fT Frx: T k>1
Frla(x).P:0

Fr Pyl Fr Pyl I—rf:ﬁéT Frx: T k> 1 f ¢ f(P1)

Frdef f = (X).Pl in Ps : 4

» Control k > [ on definition.

> Possibility of typing the encoding of Agt with level 0
everywhere (no imperative names).



Terminating example

(vlocky, .., locki)(locky | .. | lock |
def s = (c,x).c(enc[c, x]) in

def c;=Ci in ... def ¢ = Ci in
(§<C17 mSg1> | s | §<Cl7m5gn>) )
with C = (y,')./OCk,'.§<C,‘+1, dec;[y,-]).lock,-

Encryption server s

Clients ¢; into a chain data structure

No direct access to successor (informations travel through s)
Imperative locks.

vV vy vVvyy



Terminating example

(vlocky, .., locki)(locky | .. | lock |
def s = (c, )E(enc[c x]) in
def ¢c; = C1 in def ¢ = C in

(§<Cl7m5g1> | o

with

.| 5(c1, msg,)) )

C = (y,-).lock,-.E(c;+1,dec;[y,-]).lock,-

Clients ¢; into a chain data structure
No direct access to successor (informations travel through s)

1

Not typable with weights only (circularity s,c).

>  » Encryption server s
>
>
» Imperative locks.
> Typing: /ock,-o, <:,1
| 2
| 2

Logical relations not usable (lock; are imperative)
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Proof by pruning

Principles

» Define a pruning pr’r’() of hybrid processes into functional
processes.
» Obtain a simulation lemma: If P — P’ then:
1. either prf(P) ~ prf(P’)
2. or pri(P) — pre(P').
» Transform a well-typed diverging hybrid process into a
functional diverging process (2. happens infinitely often)
Raising a contradiction.



Maximum reduction level

» —p: reduction of a definition of level n.
» —: reduction of an imperative communication on level n.

Decreasing lemma

We define OsP(P) the number of available outputs of level p in P.
We prove:

> If P =0 P’ for n < p, OsP(P) = 0s”(P').
> If P =7 P’ for n < p, OsP(P) = OsP(P").
> If P =P P, OsP(P) > OsP(P').



Maximum reduction level

» —p: reduction of a definition of level n.
» —: reduction of an imperative communication on level n.

Decreasing lemma

We define OsP(P) the number of available outputs of level p in P.
We prove:

> If P =0 P’ for n < p, OsP(P) = 0s”(P').
> If P =7 P’ for n < p, OsP(P) = OsP(P").
> If P =P P, OsP(P) > OsP(P').

Maximum reduction level

» In every reduction sequence (P;);en, there exists a maximum
level p such that for an infinite number of indices i,
P,' —>l.) P,'+1.

» With the previous lemma, an infinite number of times,
Pi =% Piy1



Pruning

pri(a(x).P) = prf(la(x).P) = prf(0) = 0 pri(Pr | P2) = pri(P1) | pre(P2)

pr’r’((ua) P) = pr?(P) pr’F(E(v).P) = pr’IZ(P)
P n _ . _ def f = (X)prf-’(Pl) in prff(Pg) if n= 1%
Pri(des 7= (x).Fa 1n P) = { pre(P2) otherwise

—n ' v).P ifn=p
p _
pre(F{v).P) = { 0 otherwise

» Pruning at level p.
» Removing all imperative parts.

» Removing functional parts of level # p.



Simulation

Simulation Lemma
> If P —{ P’ for n < p then prp(P) ~ prf(P’).
> If P = P’ for n < p then prP(P) ~ prP(P’).
> If P —% P’ then prf(P) — prR(P’).



Simulation

Simulation Lemma
> If P = P’ for n < p then prP(P) ~ prP(P’).
> If P = P’ for n < p then prP(P) ~ prP(P’).
> If P—E P’ then prf(P) — prl(P).

Sketch
» P=(la"(x).Py | 3"(v).P,) with n < p.
Thus prf(P) = pri(P»).
» P— P = (1a"(x).P1 | P2 | Pi{v/x})
Thus pre(P') = pri(Pi{v/x}) | pri(P2)
» Typing !a"(x).Py implies prf(P1{v/x}) ~ 0.



Simulation

Simulation Lemma
> If P = P’ for n < p then prP(P) ~ prP(P’).
> If P = P’ for n < p then prP(P) ~ prP(P’).
> If P—E P’ then prf(P) — prl(P).

Sketch
» P=(la"(x).Py | 3"(v).P,) with n < p.
Thus prf(P) = pri(P»).
» P— P = (1a"(x).P1 | P2 | Pi{v/x})
Thus pre(P') = pri(Pi{v/x}) | pri(P2)
» Typing !a"(x).Py implies prf(P1{v/x}) ~ 0.

Remember: an infinite number of times, P; =5 Pii1.
We derive a contradiction. Every typable process terminates



Parametricity

Principles

» Using the proof of functional calculus as an argument of the
method.

» Replacing the functional 7-calculus by any terminating
functional calculus.

Examples

> Functional calculus with integer recursions:
def f = (n,x).P; in P, typed if f appears in P; only in:
f(n—1,v).

» Existential polymorphism. (No level polymorphism)

> lterating the method. (Several functional calculi).
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Boudol07/Amadio09/Madet10

Types & Effects

» Store divided into regions.

> Regions denoted by integers.

» Effect n: can act on the memory up to region n.
» T ref, well-formed, YN > n, N ¢ T.

» T —" T, function whose body has effect n.

|—rM:(T1 —)n Tg,m) FrN:(Tl,k)
Fr M N : (T2, max(m,n, k))

Fr M :(T2,n) Nx)=T Fr M : (T ref,, m)
FrAx. M : (T1 =" T2,0) Fr deref,(M) : (T, max(m, n))




Annotated reductions
Store §:

» (E[Ax.My V],6) =" p(E[M1{V/x}],0) if (Ax.My V) effect n.
» (E[deref,(u)],d(u~ V))—="1(V,d(u~ V)).

> ..

Proof by pruning

Similar principles:
> Removing imperative parts.
» Removing functional parts of level # p.
» Proving a simulation.

» Deriving a contradiction.



Pruning

» Subterm M related to the level p if:

» Type of M contains N > p,
» or M has effect > p.
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» We cannot prune subterms to 0 here:
» We introduce Vy: generic value of type T.



Pruning

» Subterm M related to the level p if:

» Type of M contains N > p,
» or M has effect > p.

» We cannot prune subterms to 0 here:

» We introduce Vy: generic value of type T.
» How to prune deref,(M)?

» M can diverges.



Pruning

» Subterm M related to the level p if:

» Type of M contains N > p,
» or M has effect > p.

» We cannot prune subterms to 0 here:
» We introduce Vy: generic value of type T.
» How to prune deref,(M)?

» M can diverges.

» We use M(12) = Ax.\y.x.

» If M is of type (T ref ) then
pre(deref,(M)) = NH2) vy pre(M).



Pruning Il

Definition

If M is not related with level p:

Otherwise:

£(
r( = Pfr(/\/’l) pre(M2)
pre(ref, /V’l) = (N™ O pri(Mh))
P(deref,(Mi)) = (N2 vy pre(My))
t(u) =0



Pruning Il

Definition
If M is not related with level p:  prf(M) =Vr
Otherwise:  prE(My M) = Pfr(/\/’l) prr(Mz)
prP(ref, M) = (N2 () pre(Mi))
prf(deref,(M)) = ( 2 vy prf (M)
i(6) = O

> Pruning of types: prP(T ref,) = unit
» If br M : (T, n) then g prE(M) = prR(T)



Proof by pruning

Simulation
> If (M,8) =] (M',§") for n < p then prf(M) —* prf(M').
> If (M,8) —p (M, §") for n < p then prf(M) —* pri(M’).
> If (M,8) —5 (M, &) then pre(M) —T prR(M’)



Proof by pruning

Simulation
> If (M,8) =] (M',§") for n < p then prf(M) —* prf(M').
> If (M,8) —p (M, §") for n < p then prf(M) —* pri(M’).
> If (M,8) —5 (M, &) then pre(M) —T prR(M’)

Proof sketch
» M = deref,(u) with n < K and u: T ref,
thus pr2(M) = N2 vy O
» (M, 6(u~ V)) =7 (M, 5(u~ V)) with M =V
» Typability + Well-formedness = V not related with level p
thus prf(V) =Vr.
» Finally prf(M) —— prf(M’).



Proof by pruning Il

Decreasing

We define the number of operators of level p of a term OsP(M)
> If (M, ) —p (M',4") for n < p then Os(M’) < Os(M).
> If (M, ) —] (M',¢") for n < p then Os(M’) < Os(M).
> If (M,8) =7 (M',8") then Os(M') < Os(M).



Proof by pruning Il

Decreasing

We define the number of operators of level p of a term OsP(M)
> If (M, ) —p (M',4") for n < p then Os(M’) < Os(M).
> If (M, ) —] (M',¢") for n < p then Os(M’) < Os(M).
> If (M,8) =7 (M',8") then Os(M') < Os(M).

Proof is done as in the 7 case.



Conclusion / Future Works

» Common refinements of the weight-based type systems
(sequences, finer analyses).

v

Parametricity (Iterating of the method).

v

Polymorphism (Types, Regions).

v

Encoding A — 7 (System T, Aper).



Q>



Appendix 1: The Example

Sys1 = (vlocka, .., locki)
( locky |..| locki |
def s = (¢, x).¢{enc[c, x]) in
def ¢ = (; in

def cx—1 = Cx_1 in
def ¢x = Cx in

(5(er,msg,) | .| S(ci, msg,)) )
with:
G déf (y,-).lock,-.(lock,— | §(c,-+1,dec,-[y,-]))
G (yi).Jocky.(locki | d(deck[yx]))
Levels

lock; : 2 unit, ¢ :#ib, s:f (#bxDb), msg :b, d:fb



Appendix 2: Another example

Sys> 1 def s = (n,r,f).
( if f = tintin then (vh) (F(h).h)
| if f = asterix then ...

| if n> 0 thens(n—1,r,f))
in (vr')( S(15,r/, tintin)

| (ve) (< | !c.r'(z).(E|Z)))

Levels
f,tintin,asterix : b, h,z:b; r,r :#ib, s:f2(nat xfEbxb), c:{b



Appendix 3: Reductions for A

(8)

(. M V,8) s (M{V/x},9)

u ¢ supp(9) FrV:(T,.) o(uy=V

(ref)

(deref)

(ref, V,8) = (u, (6(u ~ V))) (deref,(u),8) — (V,d)

Fr Vi (T,
(u:=,V, (8)) = (O, (6(u ~ V)))

(store)

(M, &) — (M, 5")
(E[M],6) — (E[M],5")

(context)



Appendix 4: Typability for A

FrM:(Tl —" Tg,m) '—rNZ(Tl,k)
Fr M N : (Ty, max(m, n, k))

(App)

}—rM:(Tz,n) I'(x)= Ty

Ab
(Abs) = M (Tr 5" T2.0)
Fr M (Tq, r =T;
(Ref) r M: (T, m) (Var) TI=T1_
Fr ref, M: (T ref,, max(n, m)) Frx:(T1,0)

(Uni) (Add)

FrO: (unit,O) Fr Uip,1y) (T1 ref,,,O)

Fr M : (T1 refn, m) Fr N (Ty, k)
Fr M:=,N : (unit, max(m, n, k))

(Asg)

Fr M : (T ref,, m)

(Drf) Fr deref,(M) : (T, max(m, n))

(Emp)m

Frd Fr Vi (T,0)
Fr o{ugn, )y ~ V)

(Sto)



Appendix 5: Pruning for A

If M is not related to p:

pre(M)
Otherwise:

)
)
)
pri(ref, M)
prf(deref,(M))

)

)

Vr

prr(Mr) pri(Mz)

AX. pr P(My)

(N 2.0 pre(Mu))

("'( 2 vy pr2(Mh))
(N3O pre(My) pre(Ms))
O



Appendix 6: 2 Lemmas for A

Dividing evaluation contexts
Let E be an evaluation context and p an integer.
1. Either for all M, prf(E[M]) = prf(E)[pri(M)]
2. Or there exists E; and Ep # [] s.t. E = E;1[Ep] and, for all M:

2.1 If M has effect > p, then

prr(E[M]) = prf(E[M]) = prr(E)[prf (M)].
2.2 If M has effect < p, then prf(E[M]) = prf(E1)[V1]
(where T" is the type of Ej).

Context reduction
If br Ex - (T, m) and E; is not related with level p, for all terms
M, M

L pri(E2)[(N2) v M)] =+ Vo,

2. prP(E2)[(N) Vr M M) —o* Vo,
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